
Appendix B. Planning and Scheduling (PAS) Screen 
Descriptions 

The objective of Planning and Scheduling system (PAS) is to allow the instrumenters at the ISTs 
and the FOT in the EOC to define and schedule activities needed to support the instrument 
science operations needs, to help the FOT produce a conflict-free schedule of activities that can 
then be used to generate appropriate command sequences for the instruments and the spacecraft. 
During all phases of scheduling, the PAS provides the authorized users with a set of tools for 
global schedule visualization and development of schedule for their own instrument. The 
Timeline tool in the PAS provides the Instrument Operations Team (IOT) at an IST with global 
visibility into planned operations of all EOS instruments and the spacecraft. The IOT may define 
activities for their instrument, and submit scheduling requests using these activities. The PAS 
ensures plan integrity using a Plan tool which manages the EOC Master plan and all user defined 
plans. The plan tool allows an authorized user to establish access for an instrument for a specific 
time period on a plan, and thus prohibits other users from modifying the same portion of the plan 
when one IOT is using it. The PAS integrates requests from an IOT with those of the other 
instruments and spacecraft. The PAS determines the TDRSS contacts needed to support the data 
volume needs of each instrument, as specified in the activity definitions, and identifies any 
possible constraints. The FOT at the EOC tries to resolve constraints with the instrumenters; in 
case of conflict, the Mission Operations Manager makes the final decision on resolving the 
conflict. 

The PAS tools include several Motif widgets consistently across several displays and tools. The 
use of these general widgets is described in section B.1. Section B.2 describes the tools provided 
as part of PAS subsystem. These tools include Activity Definer, BAP definer, Scheduler, Plan 
tool, Constraint Definer, Timeline, Communication Contact Scheduler, ATC Load generator. 
The descriptions include the usage, the access method, user interface screen samples, the input 
expected from the user, and the output for each tool. The user interface for all these tools is 
designed based on the X-windows standards, and provides a consistent look and feel for all 
displays. 

B.1 General Motif Widgets Used in PAS 

PAS system uses several standard Motif widgets and some combinations of them to provide 
consistent user interaction. These include labeled lists, time specification widgets. On the labeled 
lists, the widget consists of a label and scrolled list widget; the user can scroll the list and select 
one of the items on the list by clicking on it. On a time specification widget, the user can enter 
time values in a text field and specify the units of time on a pop-menu widget. The options 
provided on this menu are mm:ss, hh:mm:ss, ddd:hh:mm:ss, etc. 
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B.2 PAS Tools 

B.2.1 Activity Definer 

B.2.1.1 Activity Definer Usage 

The activity definer tool is used by the IOT or the EOC FOT to define an activity which is a 
logical command sequence to perform an action on an instrument or the s/c, referred to as a 
resource. An activity may or may not change the mode of the resource. An activity may or may 
not have power consumption or data rate associated with it. The tool can also be used for editing 
a previously defined activity of simply for viewing it. 

The user uses the Activity definer to define the following attributes of an activity: the ATC or 
ground script (ECL) commands with specific relative times from beginning of the activity, the 
power, data rate, any mode transitions resulting from an activity, any constraints associated with 
an activity. 

B.2.1.2 Activity Definer Access 

The activity definer is brought up when the user selects this tool from the options provided in the 
"PAS room" provided by FOS User Interface subsystem (FUI). The sample screens for the 
Activity Definer tool are shown in Figures B.2.1.3.1-1 through B.2.1.3.1-7. The following 
subsections provide the input and output for each of these display screens. 

B.2.1.3 Activity Definer Displays 

B.2.1.3.1 Activity Definer Top Level Display 

The top level display always shows summary information about an activity as it is developed by 
the user on other displays. 
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Figure B.2.1.3.1-1. Activity Definer Top Level Display 

B.2.1.3.1.1 Activity Definer Top Level Display Input 

The "File" pull-down menu on the top level screen provides the OPEN, NEW, SAVE, DELETE 
and QUIT functions, as applicable to activities. The "Edit" Pull-down menu includes the 
options for bringing up displays that support the command editing, constraint definition, mode 
transition specification, and parameter specification for the activity. 

B.2.1.3.1.2 Activity Definer Top Level Display Output 

Whenever the user selects an option from one of the two pull-down menus the appropriate 
display screen is brought up for the user to specify details on the activity. 
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B.2.1.3.2 Activity Definer Command Editor Display 

Figure B.2.1.3.2-1. Activity Definer Command Editor Display 

B.2.1.3.2.1 Activity Definer Command Editor Display Input 

Available Commands - This scrolled list widget contains the list of available commands for the 
specified resource from the Project Data base (PDB). The user can select any one command from 
this list at a time by clicking on it. 

Activity Command List - This scrolled list widget contains user selected commands; user can 
select a command from this list and then specify the time offset for the command using the Time 
specification widget below. 
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The user can select the command type and whether the offset is from the start of the activity or 
the end of the activity using the radio buttons. The use of Time specification widget is described 
in section B.1.2 above. 

The ADD button allows the user to add a command from the list of available commands to the 
Activity command list. The DELETE button allows the user to delete a previously specified 
command from the Activity command list. 

The user clicks the OK button to complete the specification for all commands. 

B.2.1.3.2.2 Activity Definer Command Editor Display Output 

The Activity command list on this display shows the user selected list of commands for the 
activity, the command type as well as the relative time offsets. When the user clicks the OK 
button, the list is transferred to the Activity Definer top level display. 

B.2.1.3.3 Activity Definer Enumerated Parameters Display 

Figure B.2.1.3.3-1. Activity Definer Enumerated Parameters Display 

B.2.1.3.3.1 Activity Definer Enumerated Parameters Display Input 
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Activity Command List - This scrolled list widget contains the list of available commands 
defined for the activity. The user can select any one command from this list at a time by clicking 
on it. The parameters for the selected command are shown on the Parameters scrolled list widget. 

Parameters - This scrolled list widget contains the list of parameters for the selected command. 
The user can select any one parameter from this list at a time by clicking on it. If the parameter is 
of the type "enumerated", the valid parameter values are displays as a scrolled list in the 
Parameter Values widget. 

Parameter Values - This scrolled list widget contains the list of valid discrete values for the 
selected parameter. The user can select any one value from this list at a time by clicking on it. 

When the user clicks the APPLY button, the selected value is shown on the command line in the 
Activity Command List widget. 

The user clicks the OK button to complete the parameter value specification for all commands. 

B.2.1.3.3.2 Activity Definer Enumerated Parameters Display Output 

The Activity Command List is updated as the user selects the parameter values for each 
command, as described above. The Parameters scrolled list always shows the valid parameters 
for the user-selected command. The default when this display comes up, is the parameters for 
the first command. When the user clicks the OK button, the list of parameters is transferred to 
the Activity Definer top level display. 

B-6 605-CD-003-001




B.2.1.3.4 Activity Definer Parameter Functions Display 

Figure B.2.1.3.4-1. Activity Definer Parameter Functions Display 

B.2.1.3.4.1 Activity Definer Parameter Functions Display Input 

Activity Command List - This scrolled list widget contains the list of available commands 
defined for the activity. The user can select any one command from this list at a time by clicking 
on it. The parameters for the selected command are shown on the Parameters scrolled list widget. 

Parameters - This scrolled list widget contains the list of parameters for the selected command. 
The user can select any one parameter from this list at a time by clicking on it. If the parameter 
has a function associated with it, the list of valid functions is provided as options on the 
Parameter Function button. 

Parameter Functions - This pop-up menu widget provides the list of valid functions defined for 
the selected parameter. The user can select any one function from this list at a time using the 
pop-up menu. 

When the user clicks the APPLY button, the selected function is shown on the command line in 
the Activity Command List widget. 
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The user clicks the OK button to complete the parameter value specification for all commands. 

B.2.1.3.4.2 Activity Definer Parameter Functions Display Output 

The Activity Command List is updated as the user selects a parameter function for each 
command, as described above. The Parameters scrolled list always shows the valid parameters 
for the user-selected command. The default when this display comes up, is the parameters for 
the first command. When the user clicks the OK button, the list of parameters is transferred to 
the Activity Definer top level display. 

B.2.1.3.5 Activity Definer Parameter Ranges Display 

Figure B.2.1.3.5-1. Activity Definer Parameter Range Display 

B.2.1.3.5.1 Activity Definer Parameter Ranges Display Input 
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Activity Command List - This scrolled list widget contains the list of available commands 
defined for the activity. The user can select any one command from this list at a time by clicking 
on it. The parameters for the selected command are shown on the Parameters scrolled list widget. 

Parameters - This scrolled list widget contains the list of parameters for the selected command. 
The user can select any one parameter from this list at a time by clicking on it. If the parameter 
has a range associated with it, the range defined in the PDB is shown in the text widgets under 
Numeric parameter values. 

Parameter Values - The text field widgets allow the user to specify new default value and another 
range for the parameter, as appropriate for the current activity. The user may change the values 
of the high and low limits or the default value by typing the values in the appropriate fields. The 
new range must be the same as or must be subset of the range defined for the command in the 
PDB. 

When the user clicks the APPLY button, the selected function is shown on the command line in 
the Activity Command List widget. 

The user clicks the OK button to complete the parameter value specification for all commands. 

B.2.1.3.5.2 Activity Definer Parameter Ranges Display Output 

The Activity Command List is updated as the user selects a parameter function for each 
command, as described above. The Parameters scrolled list always shows the valid parameters 
for the user-selected command. The default when this display comes up, is the parameters for 
the first command. When the user clicks the OK button, the list of parameters is transferred to 
the Activity Definer top level display. 
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B.2.1.3.6 Activity Definer Mode Transition Display 

Figure B.2.1.3.6-1. Activity Definer Mode Transitions Display 

B.2.1.3.6.1 Activity Definer Mode Transition Display Input 

Possible Entry Modes - This scrolled list widget contains the list of valid entry modes for the 
instrument/subsystem. The user can select any one mode from this list at a time by clicking on it. 
The user can double-click on a mode in this list to add it to the list of Valid entry modes. 

Valid Entry Modes - This scrolled list widget contains the list of user-selected entry modes for 
the instrument/subsystem. The user can double-click on a mode in this list to remove it from the 
list of Valid entry modes. 

Activity Mode - This pop-up menu widget provides the list of valid mode for the 
instrument/subsystem. The user can select any one mode from this list at a time using the pop-up 
menu. This mode will be used as the activity mode in the activity definition. 
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Exit Mode - This pop-up menu widget provides the list of valid mode for the 
instrument/subsystem. The user can select any one mode from this list at a time using the pop-up 
menu. This mode will be used as the exit mode in the activity definition. 

B.2.1.3.6.2 Activity Definer Mode Transition Display Output 

The user-selected entry modes are shown on the Valid Entry Modes scrolled list. The user­
selected Activity mode and Entry mode are shown on their respective pop-up menu widgets. 
When the user clicks the OK button, the user-specified modes are transferred to the Activity 
Definer top level display. 

B.2.1.3.7 Activity Definer Constraint Definition Display 

Figure B.2.1.3.7-1. Activity Definer Constraint Definition Display 

B.2.1.3.7.2 Activity Definer Constraint Definition Display Input 
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The user can specify the constraints between two activities or an activity and an event as a 
temporal relation between their start and/or stop times. The pop-up buttons allow the user to 
select the from options Start time, Stop Time, Entire duration. The user can select the activity 
name (for which the constraints are being defined) from the list of activities previously defined 
for the instrument, using the activities pop-up menu at the top. The user can specify the name of 
the second activity by selecting the resource and the activities defined for it. If the constraint is to 
be defined with respect to an event, the user can select S/C as the resource; in this case, the 
events will be shown as options on the pop-up menu instead of activities. 

The radio buttons for <, >, <> allow the user to specify the BEFORE, AFTER, and DURING 
constraints. The !<> radio button allows the specification of NOT During constraint. 

B.2.1.3.7.2 Activity Definer Constraint Definition Display Output 

The Constraints scrolled list shows all the constraints defined for an activity. When the user 
clicks the OK button, the list of constraints is transferred to the Activity Definer top level 
display. 

B.2.2 BAP Definer 

B.2.2.1 BAP Definer Usage 

The BAP definer tool is used by the IOT or the EOC FOT to define a Baseline Activity Profile 
(BAP) which consists of a number of activities to be scheduled for the instrument's normal or 
routine operations. 

B.2.2.2 BAP Definer Access 

The BAP Definer tool is brought up when the user selects this tool from the options provided in 
the "PAS room" provided by FUI. The sample screens for the BAP Definer tool are shown in the 
Figures B.2.2.3.1-1 through B.2.2.3.7-1. The following subsections provide the input and output 
for each of these display screens. 

B.2.2.3 BAP Definer Displays 

B.2.2.3.1 BAP Definer Top Level Display 

The top level screen display shows summary definition of a BAP as it is developed by the user 
on other displays. The "File" pull down menu on the top level screen provides the OPEN, NEW, 
SAVE, SAVE AS, DELETE and QUIT functions, as applicable to BAPs. The "Edit" pull down 
menu allows the user to bring up screen displays where he can specify Activities, Parameters, 
and Activity scheduling information. 

B-12 605-CD-003-001




Figure B.2.2.3.1-1. BAP Definer Top Level Display 

B.2.2.3.1.1 BAP Definer Top Level Display Input 

The "File" pull-down menu on the top level screen provides the OPEN, NEW, SAVE, SAVE 
AS, DELETE and QUIT functions, as applicable to baseline activity profiles. The "Edit" Pull­
down menu includes the options for bringing up displays that support the activity lists, 
scheduling information, and parameter specifications for the activities. 

B.2.2.3.1.2 BAP Definer Top Level Display Output 

Whenever the user selects an option from one of the two pull-down menus the appropriate 
display screen is brought up for the user to specify details on the baseline activity profile. 
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B.2.2.3.2 BAP Definer Activity Editor Display 

Figure B.2.2.3.2-1. BAP Definer Activity Editor Display 

B.2.2.3.2.1 BAP Definer Activity Editor Display Input 

This display is brought up when the activity list menu option under edit is pressed. When the 
user selects on an activity on the left side of the display, that activity gets placed into the bap and 
it is shown on the right side of the display. The user can place select an activity on the right side 
of the display and order the list by using the up and down arrows. The activities will move 
appropriately. When the ok button is pressed the bap is created with the activities that are on the 
right hand side and the window closes. When the Cancel button is pressed, the window closes 
and the changes are lost. When the help button is pressed, user interface help window will 
display the help information for this window. 

B.2.2.3.2.2 BAP Definer Activity Editor Display Output 

When the user has pressed the ok button the activities will be placed within the bap and the 
window will close. If the Cancel button is pressed, the window closes and the changes are lost. 
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When the help button is pressed, user interface help window will display the help information for 
this window. 

B.2.2.3.3 BAP Definer Enumerated Parameters Display 

Figure B.2.2.3.3-1. BAP Definer Enumerated Parameters Display 
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B.2.2.3.3.1 BAP Definer Enumerated Parameters Display Input 

This window is brought up when the user selects the edit parameters from the edit menu on the 
main window. In this window the user first selects which activity to edit the parameters. Then 
they choose which command and then which parameter they wish to modify. Depending 
whether the parameter value is a numeric, an enumerated type, or a function the appropriate 
parameter widgets to enter the data will appear. In this case it is an enumerated type. The user 
will then choose the desired value. When the ok button is pressed the window will close and the 
displayed value will be applied. After the apply button is pressed, the value shown will be 
applied to that activity. When the cancel button is pressed, the window will close and the 
changed values shown will not take effect. After the help button is pressed, the user interface 
help display will show the help information for this window. 

B.2.2.3.3.2 BAP Definer Enumerated Parameters Display Output 

When the ok button is pressed the window will close and the displayed value will be applied. 
After the apply button is pressed, the value shown will be applied to that activity. When the 
cancel button is pressed, the window will close and the changed values shown will not take 
effect. After the help button is pressed, the user interface help display will show the help 
information for this window. 
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B.2.2.3.4 BAP Definer Parameter Functions Display 

Figure B.2.2.3.4-1. BAP Definer Parameter Functions Display 

B.2.2.3.4.1 BAP Definer Parameter Functions Display Input 

This window is brought up when the user selects the edit parameters from the edit menu on the 
main window. In this window the user first selects which activity to edit the parameters. Then 
they choose which command and then which parameter they wish to modify. Depending 
whether the parameter value is a numeric, an enumerated type, or a function the appropriate 
parameter widgets to enter the data will appear. In this case it is a function. The user will then 
choose the desired function. When the ok button is pressed the window will close and the 
displayed value will be applied. After the apply button is pressed, the value shown will be 
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applied to that activity. When the cancel button is pressed, the window will close and the 
changed values shown will not take effect. After the help button is pressed, the user interface 
help display will show the help information for this window. 

B.2.2.3.4.2 BAP Definer Parameter Functions Display Output 

When the ok button is pressed the window will close and the displayed value will be applied. 
After the apply button is pressed, the value shown will be applied to that activity. When the 
cancel button is pressed, the window will close and the changed values shown will not take 
effect. After the help button is pressed, the user interface help display will show the help 
information for this window. 
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B.2.2.3.5 BAP Definer Parameter Ranges Display 

Figure B.2.2.3.5-1. BAP Definer Parameter Range Display 
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B.2.2.3.5.1 BAP Definer Parameter Ranges Display Input 

This window is brought up when the user selects the edit parameters from the edit menu on the 
main window. In this window the user first selects which activity to edit the parameters. Then 
they choose which command and then which parameter they wish to modify. Depending 
whether the parameter value is a numeric, an enumerated type, or a function the appropriate 
parameter widgets to enter the data will appear. In this case it is a numeric type. The user will 
then enter the desired value. When the ok button is pressed the window will close and the 
displayed value will be applied. After the apply button is pressed, the value shown will be 
applied to that activity. When the cancel button is pressed, the window will close and the 
changed values shown will not take effect. After the help button is pressed, the user interface 
help display will show the help information for this window. 

B.2.2.3.5.2 BAP Definer Parameter Ranges Display Output 

When the ok button is pressed the window will close and the displayed value will be applied. 
After the apply button is pressed, the value shown will be applied to that activity. When the 
cancel button is pressed, the window will close and the changed values shown will not take 
effect. After the help button is pressed, the user interface help display will show the help 
information for this window. 
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B.2.2.3.6 BAP Definer Events Scheduling Information Display 

Figure B.2.2.3.6-1. BAP Definer Scheduling Information Displayusing Events and 
Duration 

B.2.2.3.6.1 BAP Definer Events Scheduling Information Display Input 

This window is brought up when the user chooses the scheduling information option from the 
edit menu on the main window. The user first chooses an activity. Then they choose if the start 
time of the activity is to be scheduled off of an event or if the activity is to be repeated on a 
regular interval. In this case the user chooses to enter the start time by an event. Therefore they 
need to first select an orbital event. Then enter the offset and whether the offset is before or after 
the event. Once this has been entered the stop time for an activity needs to be entered. The user 
may choose either event or duration. The event is the same as the start time and the duration is 
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just the duration of the activity from the start time. When the user presses the ok button the 
window will close and the scheduling information will be applied for that activity. When the 
apply button is pressed the shown information is applied. If cancel is selected the window will 
close and if the help option is selected the user interface will display the help information. 

B.2.2.3.6.2 BAP Definer Events Scheduling Information Display Output 

When the user presses the ok button the window will close and the scheduling information will 
be applied for that activity. When the apply button is pressed the shown information is applied. 
If cancel is selected the window will close and if the help option is selected the user interface will 
display the help information. 
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B.2.2.3.7 BAP Definer Reference time Scheduling Information Display 

Figure B.2.2.3.7-1. BAP Definer Scheduling Information Displayusing Reference 
Time and Duration 

B.2.2.3.7.1 BAP Definer Reference time Scheduling Information Display Input 

This window is brought up when the user chooses the scheduling information option from the 
edit menu on the main window. The user first chooses an activity. Then they choose if the start 
time of the activity is to be scheduled off of an event or if the activity is to be repeated on a 
regular interval. In this case the user chooses a repeated interval. Therefore they need to enter a 
reference date and a frequency. Once this has been entered the stop time for an activity needs to 
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be entered. The user may choose either by event or duration. The event is the same as the start 
time and the duration is just the duration of the activity from the start time. When the user 
presses the ok button the window will close and the scheduling information will be applied for 
that activity. When the apply button is pressed the shown information is applied. If cancel is 
selected the window will close and if the help option is selected the user interface will display the 
help information. 

B.2.2.3.7.2 BAP Definer Reference time Scheduling Information Display Output 

When the user presses the ok button the window will close and the scheduling information will 
be applied for that activity. When the apply button is pressed the shown information is applied. 
If cancel is selected the window will close and if the help option is selected the user interface will 
display the help information. 

B.2.3 Scheduler 

B.2.3.1 Scheduler Usage 

The Scheduler tool is used by the IOT or the EOC FOT to schedule an activity, a BAP, or a 
single command. 

B.2.3.2 Scheduler Access 

The Scheduler tool is brought up when the user selects this tool from the options provided in the 
"PAS room" provided by FUI. The sample screens for the Scheduler tool are shown in Figures 
B.2.3.3.1-1 through B.2.3.3.3-1. 

B.2.3.3 Scheduler Displays 
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B.2.3.3.1 Scheduler Display for BAP Scheduling 

Figure B.2.3.3.1-1. Scheduler Display : BAP Scheduling 

B.2.3.3.1.1 Scheduler Display Input for BAP Scheduling 

The Scheduler display for bap scheduling is shown in Figure B.2.3.3.1-1. The file menu 
provides the user the option of exiting the application. The Edit menu allows the user to modify 
the activity parameters and since these screens are identical to the activity definer windows the 
displays are shown there. The view option displays the currently selected bap since the bap 

B-25 605-CD-003-001




toggle button is pressed. The help menu brings up the user interface help process that will 
display the help text. To schedule a bap the user will first select a resource and then make sure 
that the bap toggle button is pressed. Then they will select a bap and a plan. Next an absolute 
start time is entered. After the start time has been entered the user needs to provide the stop time. 
This may be given either in an absolute time or by a duration. In this case the duration has been 
selected. The user enters how long the bap is to be scheduled and then presses the schedule 
button to schedule the bap. 

B.2.3.3.1.2 Scheduler Display Output for BAP Scheduling 

The file menu provides the user the option of exiting the application. The Edit menu allows the 
user to modify the activity parameters and since these screens are identical to the activity definer 
windows the displays are shown there. The view option displays the currently selected bap since 
the bap toggle button is pressed. The help menu brings up the user interface help process that 
will display the help text. When the user presses the schedule button to schedule a bap, the 
activities will be scheduled. This can be viewed from the timeline. 
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B.2.3.3.2 Scheduler Display for Activity Scheduling 

Figure B.2.3.3.2-1. Scheduler Display : Activity Scheduling 
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B.2.3.3.2.1 Scheduler Display Input for Activity Scheduling 

The Scheduler display for activity scheduling is shown in Figure B.2.3.3.2-1. The file menu 
provides the user the option of exiting the application. The Edit menu allows the user to modify 
the activity parameters and since these screens are identical to the activity definer windows the 
displays are shown there. The view option displays the currently selected activity since the 
activity toggle button is pressed. The help menu brings up the user interface help process that 
will display the help text. To schedule an activity the user will first select a resource and then 
make sure that the activity toggle button is pressed. Then they will select an activity and a plan. 
Next the user specifies how the start time for the activity is determined. Either by an orbital 
event or by an absolute time. In this example the user chose to schedule the activity by an orbital 
event by pressing the event toggle button. The user selects which orbital event and enters the 
offset. Next the time of the event is entered either from the timeline or by the user entering the 
time. Once this has been accomplished the user needs to provide the stop time. This may be 
given either by an orbital event, an absolute time, or by a duration. In this case the duration has 
been selected. The user enters how long the activity is to be scheduled and then presses the 
schedule button to schedule the activity. 

B.2.3.3.2.2 Scheduler Display Output for Activity Scheduling 

The file menu provides the user the option of exiting the application. The Edit menu allows the 
user to modify the activity parameters and since these screens are identical to the activity definer 
windows the displays are shown there. The view option displays the currently selected activity 
since the activity toggle button is pressed. The help menu brings up the user interface help 
process that will display the help text. When the user presses the schedule button to schedule an 
activity, the activity will be scheduled. This can be viewed from the timeline. 
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Figure B.2.3.3.3-1. Scheduler Display : Command Scheduling 
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B.2.3.3.3.1 Scheduler Display Input for Command Scheduling 

The Scheduler display for command scheduling is shown in Figure B.2.3.3.3-1. The file menu 
provides the user the option of exiting the application. The Edit menu allows the user to modify 
the command parameters and since these screens are identical to the activity definer windows the 
displays are shown there. The view option has no functionality when scheduling commands so 
the view menu option does nothing. The help menu brings up the user interface help process that 
will display the help text. To schedule a command the user will first select a resource and then 
make sure that the command toggle button is pressed. Then they will select a command and a 
plan. Next the user specifies the absolute time of when the command will be scheduled and then 
presses the schedule button to schedule the command. 

B.2.3.3.3.2 Scheduler Display Output for Command Scheduling 

The file menu provides the user the option of exiting the application. The Edit menu allows the 
user to modify the command parameters and since these screens are identical to the activity 
definer windows the displays are shown there. The view option has no functionality when 
scheduling commands so the view menu option does nothing. The help menu brings up the user 
interface help process that will display the help text. When the user presses the schedule button 
to schedule a command, the command will be scheduled. This can be viewed from the timeline. 

B.2.4 Plan Tool 

B.2.4.1 Plan Tool Usage 

The Plan tool is used by the IOT or the EOC FOT to establish accesses, permissions or locks on 
plans maintained by the PAS system. These include the Master EOC plan or one of the What-if 
plans defined by the users. 

B.2.4.2 Plan Tool Access 

The Plan tool is brought up when the user selects this tool from the options provided in the "PAS 
room" provided by FUI. The sample screens for the Plan tool are shown in Figures B.2.4.3.1-1 
through B.2.4.3.3-1. 

B.2.4.3 Plan Tool Displays 

B.2.4.3.1 Plan Tool Top Level Display 

The plan tool allows the user-group to select a plan and set permissions and/or locks on them at 
the resource level. When one user-group has set an access on a resource for a time period on a 
given plan, any other user-group may not schedule an activity on it for the same resource during 
that period. This allows plan integrity, and enforces user coordination on use of plans. 
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Figure B.2.4.3.1-1. Plan Tool Top Level Display 

B.2.4.3.1.1 Plan Tool Top Level Display Input 

The "File" pull-down menu on the top level display provides the NEW, OPEN, CLOSE, COPY, 
SAVE, SAVE AS, DELETE, PRINT and QUIT functions applicable to the maintenance of 
plans. The "Edit" pull-down menu includes options for setting permissions on plans by resource, 
setting lock times and changing the time range on plans. The displays for the NEW, OPEN, 
CLOSE, COPY, SAVE, SAVE AS, DELETE, PRINT options simply allow the user to type in 
the name of the plan on which to operate, and the OK, CANCEL and HELP buttons. 

B.2.4.3.1.2 Plan Tool Top Level Display Output 

The main screen transitions to the appropriate display whenever the user selects an option from 
one of the pull-down menus. It also provides a summary of the currently opened plans. 
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B.2.4.3.2 Plan Tool Permissions Display 

Figure B.2.4.3.2-1. Plan Tool Permissions Display 

B.2.4.3.2.1 Plan Tool Permissions Display Input 

The plan permissions screen requires the user to select a group or groups for which they would 
like to allow permission to update the selected plan. The user also must select the resource or 
resources on the plan for which permissions will be granted. After the selections are made the 
user may either confirm the selection and return to the main screen by selecting the "OK" button 
or may confirm the selection and remain at this screen by selecting "APPLY". If the user decides 
to cancel the changes they have made, the user selects "CANCEL". 
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B.2.4.3.2.2 Plan Tool Permissions Display Output 

The display highlights the user groups that the user has selected. It also shows the selected 
resources in the "Selected Resources" list. 

B.2.4.3.3 Plan Tool Locks Display 

Figure B.2.4.3.3-1. Plan Tool Locks Display 

B.2.4.3.3.1 Plan Tool Locks Display Input 

If the user wishes to change a lock time, the user would use this display to enter the appropriate 
information. The user selects a resource for which they would like to change the lock time and 
enters the lock time in the "LOCK TIME" field. After the selections are made, the user selects 
the "OK" button to confirm the changes or selects "CANCEL" to cancel the changes. 

B.2.4.3.3.2 Plan Tool Locks Display Output 

The output of the plan tool locks display screen will highlight any resource chosen and will show 
the current lock time for each resource. 
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B.2.5 Timeline 

B.2.5.1 Timeline Usage 

The Timeline tool is used by the IOT or the EOC FOT to view modeling data contained within 
the resource model. The data the timeline displays include activities that resources perform 
through time, constraints related to those activities, FDF planning aid information, subscribable 
resource utilization information, and system user scheduling write accesses. Besides 
visualization, the timeline allows performs a number of scheduling functions. The functions 
include removing activities from a schedule and creating and deleting write accesses for the 
current user. 

B.2.5.2 Timeline Access 

The Timeline tool is brought up when the user selects this tool from the options provided in the 
"PAS room" provided by FUI. The sample screens for the Timeline tool are shown in the Figures 
B.2.5.3.1-1 through B.2.5.3.6-1. The following subsections provide the input and output for each 
of these display screens. 

B.2.5.3 Timeline Displays 

B.2.5.3.1 Timeline Top Level Display 

The top level screen display shows a variety of information. Each row of the timeline represents 
information about a resource through time. A user can summary definition of a BAP as it is 
developed by the user on other displays. The "File" pull down menu on the top level screen 
provides the OPEN, NEW, SAVE, SAVE AS, DELETE and QUIT functions, as applicable to 
BAPs. The "Edit" pull down menu allows the user to bring up screen displays where he can 
specify Activities, Parameters, and Activity scheduling information. 
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Figure B.2.5.3.1-1. Timeline Top Level Display 

B.2.5.3.1.1 Timeline Top Level Display Input 

From the top level display of the timeline a user can view one plan at a time. The time span that 
is viewed can be changed to show more or less time by using the option pop-up menu near the 
lower-left portion of the screen. The horizontal scroll-bar along the bottom of the screen allows 
users to scroll through time. The vertical scroll-bar along the right side of the timeline allows 
users to scroll and zoom in and out of the resources displayed on the timelines main display 
region in the center of the display. Toggle buttons along the left give users the opportunity to 
select those resources that the user needs to obtain write access to for scheduling. 

The "File" pull-down on the main menu bar provides PRINT and QUIT functions. The "Edit" 
pull-down offers MODIFY ACTIVITY and REMOVE ACTIVITY. The "View" pull-down 
provides the user to select between the two different views of activities and accesses. The 
"Preferences" pull-down allows users to specify desired configurations of the timeline that 
include COLOR, RESOURCES, FILTER and SAVE CONFIGURATION. The "Plans" pull­
down selections vary from session to session depending upon what plans are open and available 
for display. 

B.2.5.3.1.2 Timeline Top Level Display Output 

By selecting the option pop-up menu the center display portion of the timeline will change to 
display the amount of time selected. When users click and drag on the time scroll-bar the display 
portion will again update to show the time range that the user wished to view. Similarly, a user 
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may grab the center of the resource scroll-bar to scroll through the resources vertically. The 
timeline display will update to show the same number of resources but a different variety. By 
grabbing the ends of the scroll-bar the timeline's main display zooms in and out vertically 
showing more or fewer resources. The toggle buttons, when pressed update the write accesses 
that are displayed on the access view of the timeline. 

Whenever the user selects an option from one of the five pull-down menus the appropriate action 
is taken which includes displaying a dialog box or performing some timeline function. 

Display screens are brought up for the PRINT, MODIFY ACTIVITY, COLORS, RESOURCES, 
and FILTER selections. The QUIT option quits the timeline process. The REMOVE ACTIVITY 
removes the selected activity from the main timeline's display region. Selecting the 
ACTIVITIES option changes the timeline display to show activities and the ACCESSES shows 
user write access privileges. SAVE CONFIGURATION saves the display configuration and 
selecting a plan from the "Plans" pull-down will cause the timeline to update and display that 
plan. 

B.2.5.3.2 Timeline Write Accesses Display 

Figure B.2.5.3.2-1 Timeline Write Accesses Display 

B.2.5.3.2.1 Timeline Write Accesses Display Input 

The access view of the timeline contains the same inputs as the main timeline. See Section 
B.2.5.3.1.1 for a complete description. 
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B.2.5.3.2.2 Timeline Write Accesses Display Output 

The access view of the timeline contains the same outputs as the main timeline. See Section 
B.2.5.3.1.2 for a complete description. 

B.2.5.3.3 Timeline Color Changer Display 

Figure B.2.5.3.3-1. Timeline Color Changer Display 

B-37 605-CD-003-001




B.2.5.3.3.1 Timeline Color Changer Display Input 

The Timeline Color Changer display contains a palette of colors a user may select from. The 
display also includes a scrollable list of activity and event types a user may choose from thereby 
associating a color. 

B.2.5.3.3.2 Timeline Color Changer Display Output 

The APPLY button when pressed causes the timeline's main display to update to reflect the color 
changes that were made using the Color Changer display. The OK button also applies the 
changes and also closes the panel. 

B.2.5.3.4 Timeline Resource Chooser Display 

Figure B.2.5.3.4-1. Timeline Resource Chooser Display 

B.2.5.3.4.1 Timeline Resource Chooser Display Input 

Select Resources To Display - This dual set of scrolled list widgets contains on the left the total 
list of available resources for display. The list widget on the right contains those resources the 
user wishes to display. 

B.2.5.3.4.2 Timeline Resource Chooser Display Output 

The APPLY button causes the timeline's main display to update to show those resources the user 
selected. The OK button also changes the timeline's main display and also closes the panel. 

B-38 605-CD-003-001




B.2.5.3.5 Timeline Time Range Display 

Figure B.2.5.3.5-1. Timeline Time Range Display 

B.2.5.3.5.1 Timeline Time Range Display Input 

The time range panel displays the time range that the current plan displayed on the timeline is 
open for. Users can modify the start or stop time of the open plan by entering the times into the 
text field widgets. 

B.2.5.3.5.2 Timeline Time Range Display Output 

Pressing on the OK button causes the timeline's main display to update to show that the total time 
range a user can scroll about in has changed. This action has the same effect as closing this plan 
using the Plan Tool and re-opening the same plan but for a new time range. 
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B.2.5.3.6 Timeline Activity/Event Filter Display 

Figure B.2.5.3.6-1. Timeline Activity/Event Filter Display 

B.2.5.3.6.1 Timeline Activity/Event Filter Display Input 

The Resource option menu widgets allow the user to select from all resources that a user can 
filter out activities and events that are displayed on the timeline. The dual scrolled list widget 
displays all the activities and events associated with the resource on the left and the list of 
activities and events that a user wishes to display in the right list. 

B.2.5.3.6.2 Timeline Activity/Event Filter Display Output 

The OK button, when pressed, updates the timeline's main display to show those activities and 
events specified in the Activity/Event Filter display. 

B.2.6 Recycler 

B.2.6.1 Recycler Usage 

The activity recycler serves as a collection point for activities that have been removed from a 
plan. From this list of activities, the user may select one or more activities to be rescheduled on 
the plan they were removed from, or to be removed completely from the system. In order to aid 
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the user in finding the desired activities to reschedule or delete, the activity recycler provides a 
series of filters that can be set to limit the activities displayed on the primary display. 

B.2.6.2 Recycler Access 

The activity recycler is brought up when the user selects this tool from the options provided in 
the "PAS room" provided by FOS User Interface subsystem (FUI). The sample screens for the 
activity recycler are shown in Figures B.2.6.3.1-1 through B.2.6.3.5-1. The following 
subsections provide the input and output of each of these display screens. 

B.2.6.3 Recycler Displays 

B.2.6.3.1 Recycler Top Level Display 

The activity recycler top level display shows a list of activities that have been removed from 
plans. The activities in the list are determined by the settings of the various filters available to 
the user. 

Figure B.2.6.3.1-1. Recycler Top Level Display 
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B.2.6.3.1.1  Recycler Top Level Display Input 

The "File" pulldown menu provides the EMPTY and QUIT functions. EMPTY will delete all 
activities currently displayed in the recycler, while QUIT will quit the application. The "Filter" 
menu has options for TIME, RESOURCE, PLAN, ACTIVITY, ACCESS, ALL, LOAD and 
SAVE. Time, resource, plan, and activity bring up displays that allow filtering of displayed 
activities based on the corresponding label. Access toggles filtering by access on and off. All 
will bring up all of the filtering displays. Load and Save allow the user to load a filter 
configuration or save the current filter configuration. The "View" menu contains ACTIVITY 
DETAILS, which will bring up the activity view pop-up for the first of the currently selected 
activities. 

The "Unscheduled Activities" list displays all of the unscheduled activities, based on the filtering 
information set by the user. The user may select one or more activities from this list. 

The DELETE button will delete all of the activities selected by the user. The reschedule button 
will reschedule all of the activities selected by the user. 

B.2.6.3.1.2 Recycler Top Level Display Output 

Selection of options from the menus at the top of the screen will cause any appropriate screens to 
appear for further selections. The Unscheduled activities list will always show the current 
unscheduled activities that are appropriate for the selected filtering options. 

B.2.6.3.2 Recycler Activity Filter Display 

Figure B.2.6.3.2-1. Recycler Activity Filter Display 
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B.2.6.3.2.1 Recycler Activity Filter Display Input 

Choose Activity Types - This scrollable list allows the user to select activity types. 

Selected Activity Types - This scrollable list allows the user to select activity types. 

The OK button applies the changes the user has made and closes the window. The APPLY 
button applies the changes, but does not close the window. The CLEAR button removes any 
changes made since the last ok or apply. The DISMISS button clears any changes and also 
closes the window. 

B.2.6.3.2.2 Recycler Activity Filter Display Output 

When the user selects an activity type from the Choose Activity Types list, the selected activity 
will be moved to the Selected Activity Types list. Similarly, selection of an activity type from 
the Selected Activity Types list will move that activity to the Choose Activity Types list. 
Pressing the OK or APPLY buttons will set the new filtering information, and cause the Top 
Level display to update its list of unscheduled activities. 

B.2.6.3.3 Recycler Plan Filter Display 

Figure B.2.6.3.3-1. Recycler Plan Filter Display 

B.2.6.3.3.1 Recycler Plan Filter Display Input 

Choose Plans - This scrollable list allows the user to select a plan. 
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Selected Plans - This scrollable list displays the user-selected plan. 

The OK button applies the changes the user has made and closes the window. The APPLY 
button applies the changes, but does not close the window. The CLEAR button removes any 
changes made since the last ok or apply. The DISMISS button clears any changes and also 
closes the window. 

B.2.6.3.3.2 Recycler Plan Filter Display Output 

When the user selects a plan from the Choose Plans list, the selected plan will be moved to the 
Selected Plans list. Choosing a plan from the Selected Plans list will cause that plan to be moved 
to the Choose Plans list. Pressing the OK or APPLY buttons will set the new filtering 
information, and cause the Top Level display to update its list of unscheduled activities. 

B.2.6.3.4 Recycler Resource Filter Display 

Figure B.2.6.3.4-1. Recycler Resource Filter Display 

B.2.6.3.4.1 Recycler Resource Filter Display Input 

Choose Resources - This scrollable list allows the user to select a resource. 

Selected Resources - This scrollable list allows the user to select a resource. 

The OK button applies the changes the user has made and closes the window. The APPLY 
button applies the changes, but does not close the window. The CLEAR button removes any 
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changes made since the last ok or apply. The DISMISS button clears any changes and also 
closes the window. 

B.2.6.3.4.2 Recycler Resource Filter Display Output 

When a resource is selected from the Choose Resources list, it will be moved to the Selected 
Resources list. Choosing a resource from the Selected Resources list will move it to the Choose 
Resources List. Pressing the OK or APPLY buttons will set the new filtering information, and 
cause the Top Level display to update its list of unscheduled activities. 

B.2.6.3.5 Recycler Time Filter Display 

Figure B.2.6.3.5-1. Recycler Time Filter Display 

B.2.6.3.5.1 Recycler Time Filter Display Input 

Show activities in time interval: 

start - allows the user to enter a date and time for the start of a time interval. 

end - allows the user to enter a date and time for the end of a time interval. 

Activities on boundaries allows the user to select one of included or not included. 

The OK button applies the changes the user has made and closes the window. The APPLY 
button applies the changes, but does not close the window. The CLEAR button removes any 
changes made since the last ok or apply. The DISMISS button clears any changes and also 
closes the window. 

B.2.6.3.5.2 Recycler Time Filter Display Output 
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Pressing the OK or APPLY buttons will set the new filtering information and cause the Top 
Level display to update its list of unscheduled activities. 

B.2.7 Load Scheduler 

B.2.7.1 Load Scheduler Usage 

The Load Scheduler Tool will provide the capability to schedule the uplink times for the various 
spacecraft and instrument loads, including instrument microprocessor loads, flight software 
loads, table loads and RTS loads. The user-specified time period corresponds to an uplink 
window (e.g. a 6 hour time period) that the FOT/IOTs desire their load to be sent. The Load 
Scheduler Tool will use this time window to select three valid communication contacts to uplink 
the specified load, the first being designated the prime contact, while the remaining two are 
backups. If three valid communication contacts are found, the user will be notified of the chosen 
communication contacts through their timeline display and status messages. During generation 
of the ground script, the command procedures for uplinking the load will be inserted into the 
ground script for execution by the FOT. 

B.2.7.2 Load Scheduler Access 

The Load Scheduler Tool is launched by the Load Manager Tool provided by the User Interface 
Subsystem. The Load Manager Tool provides the Load Scheduler Tool with the name of the 
load the user desires to schedule. The Load Scheduler Tool sends the Load Manager Tool status 
information pertaining to the scheduling of the load. The following subsections provide 
information pertaining to each of the tool displays. 

B.2.7.3 Load Scheduler Displays 

B.2.7.3.1 Load Scheduler Top Level Display 

The Load Scheduler top level display is shown in Figure B.2.7.3.1-1. General information 
pertaining to the load is displayed in the upper portion of the window. Using this display, a user 
can schedule an uplink time associated with the load. 

B-46 605-CD-003-001




Figure B.2.7.3.1-1. Load Scheduler Top Level Display 

B.2.7.3.1.1 Load Scheduler Top Level Display Input 

The Load Scheduler top level display contains three pull down menus as described in table 
B.2.7.3.1.1-1. The user selects the plan they desire the activity to be scheduled on from the 
labeled list "Plans". The uplink window start time can be entered as an orbital event or an 
absolute time. If the user selects the "Orbital Event" radio button, they can select the desired 
event on their timeline display with the mouse, automatically sending the event information to 
the Load Scheduler tool. The "+" and "-" radio buttons allow a user to select a positive or 
negative delta time from the event. The delta time is entered in the text field next to the "+" and 
"-" radio buttons, with the time format determined by the pull-down menu. The user can enter an 
absolute time for the uplink window start by selecting the "Absolute Time" radio button. 
Entering the uplink window end time is identical to entering the uplink window start time, with 
the addition of allowing a user to enter a duration by choosing the "Duration" radio button. Once 
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the scheduling information is entered on the display, the user presses the "schedule" button for 
constraint checking and integration into the mission plan. 

Table B.2.7.3.1.1-1. Load Scheduler Menu Options 
Menu Name Menu Options Description 

File Quit Causes the Load Scheduler to quit. 

View Activity Creates the Activity View pop-up window for viewing 
an activity definition. 

Help Provides the user with help information pertaining to 
the Load Scheduler Tool 

B.2.7.3.1.2 Load Scheduler Top Level Display Output 

If three valid communication contacts are found, the user will be notified of the chosen 
communication contacts through their timeline display and event handler. Similarly, if 
constraints are found (e.g. no TDRSS contacts available), the user is notified by constraint 
messages in their event handler. 

B.2.7.3.2 Load Scheduler Activity View Display 

The Load Scheduler Activity View display is shown in Figure B.2.7.3.2-1. General information 
pertaining to the uplink activity database definition is shown by this window in a read-only 
fashion. 
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Figure B.2.7.3.2. Load Scheduler Activity View Display 

B.2.7.3.2.1 Load Scheduler Activity View Input 

The list of "Commands" and "Activity Constraints" displayed by the Load Scheduler Activity 
View window are pulled from the configuration controlled project database. All information is 
non-modifiable and shown to the user for informational purposes only. 

B.2.7.3.2.2 Load Scheduler Activity View Output 

The list of "Commands" and "Activity Constraints" displayed by the Load Scheduler Activity 
View window are pulled from the configuration controlled project database. All information is 
non-modifiable and shown to the user for informational purposes only. 
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B.2.8 ATC Load Generator 

B.2.8.1 ATC Load Generator Usage 

The ATC Load Generator tool will provide the capability to generate an ATC load for a user 
specified time duration. During load generation, the activities within the user specified portion 
are frozen to allow no further schedule changes by the IOTs and FOT, resulting in the Detailed 
Activity Schedule. Activity-level constraints are checked within the DAS to verify no hard 
constraints exist. A load will not be generated if hard constraints are found, relying on the FOT 
to manually resolve the conflicts. If soft constraints are found, the user is notified and given the 
option to accept or reject the DAS. Once created, the DAS is submitted to CMS for command­
level constraint checking and generation of the associated ATC load. 

During any phase of schedule development, the ATC Load Generator tool can be run in an 
analysis mode, allowing activity and command-level constraints to be checked without 
generation of a DAS and ATC load. In addition, simulation loads can be generated to support 
mission tests that involve the spacecraft simulator. 

B.2.8.2 ATC Load Generator Access 

The ATC Load Generator tool is brought up when the user selects this tool from the options 
within the "PAS room" provided by the FOS User Interface Subsystem. The following 
subsections provide information pertaining to each of the tool displays. 

B.2.8.3 ATC Load Generator Displays 

B.2.8.3.1 ATC Load Generator "DAS/ATC Load" Display 

The ATC Load Generator "DAS/ATC Load" display is shown in Figure B.2.8.3.1-1. This 
display is shown when the user selects the create "DAS/ATC Load" radio button at the top of the 
display. With this window, a user can generate an ATC load for a specified portion of the 
mission schedule. 
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Figure B.2.8.3.1-1 ATC Load Generator "DAS/ATC Load" Display 

B.2.8.3.1.1 ATC Load Generator "DAS/ATC Load" Display Input 

The ATC Load Generator display contains three pull down menus as described in table 
B.2.8.3.1.1-1. The "Plans" labeled list will only show the EOC Master Plan as being available 
for ATC load generation. 

The "DAS Times" pertains to the time interval over which the Detailed Activity Schedule and 
associated ATC loads will be generated. The DAS "Start Time" is read-only because it is based 
on the stop time of the previously generated DAS and ATC Load, enforcing continuity of the 
generated loads. The DAS "Stop Time" is a text field in which the user can enter the stop time of 
the ATC load. 

The "Uplink Request" indicates the time period over which the user would prefer the FOT to 
uplink the generated ATC load. The "Start Time" and "Stop Time" text fields are used for 
entering the uplink window times. 
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The "Jobs Information" labeled list shows the status of the ATC Load Generator processing jobs. 
Users can move pending jobs up and down in the queue with the arrow buttons on the right. In 
addition, a user can select a job and choose "Cancel" from the "Jobs" pull down menu to remove 
it from the queue. 

Table B.2.8.3.1.1-1. ATC Load Generator Menu Options 
Menu Name Menu Options Description 

File Quit Causes the Load Generator to quit. 

Generate Processes the requested based on user specified 
information 

Delete Brings up dialog box that allows the user to delete a 
DAS and its associated ATC loads. 

Jobs Cancel Cancels a job from the queue 

Constraints Brings up a dialog box that allows the user to approve 
or disapprove soft constraints 

Show Status shows status of jobs 

Help Provides the user with help information pertaining to 
the Load Generator Tool 

B.2.8.3.1.2 ATC Load Generator "DAS/ATC Load" Display Output 

As a load is being generated, the processing status is displayed in the "Jobs Information" portion 
of the ATC Load Generator window. The output product is a generated ATC Load that is 
available for uplink by the FOT. 

B.2.8.3.2 ATC Load Generator "Late Change" Display 

The ATC Load Generator "Late Change" display is shown in Figure B.2.8.3.2-1. This display is 
shown when the user selects the create "Late Change" radio button at the top of the display. 
With this window, a user can generate an ATC load in response to a late change in the mission 
schedule. 
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Figure B.2.8.3.2-1. ATC Load Generator "Late Change" Display 

B.2.8.3.2.1 ATC Load Generator "Late Change" Display Input 

The ATC Load Generator display contains three pull down menus as described in table 
B.2.8.3.1.1-1. The "Plans" labeled list will only show the EOC Master Plan as being available 
for a late change ATC load generation. 

The Late Changes "Start Time" is a text field entered by a user to indicate the time in which the 
late change begins in the mission schedule. All impacted loads will be regenerated to incorporate 
the modified mission schedule. The Detailed Activity Schedules that are impacted by the user 
entered Late Change "Start Time" are displayed in the read-only labeled list "Impacted DAS". 
To aid the user in choosing the Late Change "Start Time", an "Allowable Period" is shown that 
indicates the time period over which a late change is acceptable. 

The "Jobs Information" labeled list shows the status of the ATC Load Generator processing jobs. 
Users can move pending jobs up and down in the queue with the arrow buttons on the right. In 
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addition, a user can select a job and choose "Cancel" from the "Jobs" pull down menu to remove 
it from the queue. 

B.2.8.3.2.2 ATC Load Generator "Late Change" Display Output 

As a load is being generated, the processing status is displayed in the "Jobs Information" portion 
of the ATC Load Generator window. The output product is one or more regenerated ATC Loads 
that are available for uplink by the FOT. 

B.2.8.3.3 ATC Load Generator "Constraint Check" Display 

The ATC Load Generator "Constraint Check" display is shown in Figure B.2.8.3.3-1. This 
display is shown when the user selects the create "Constraint Check" radio button at the top of 
the display. With this window, a user can run the ATC Load Generator in an analysis mode, 
allowing activity and command-level constraints to be checked without generation of a DAS and 
ATC load. 

Figure B.2.8.3.3-1. ATC Load Generator "Constraint Check" Display 
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B.2.8.3.3.1 ATC Load Generator "Constraint Check" Display Input 

The ATC Load Generator display contains three pull down menus as described in table 
B.2.8.3.1.1-1. The "Plans" labeled list will show the EOC Master Plan and any user created 
"what if" plans as being available for constraint checking. The user selects the plan they are 
interested in from this list labeled list. 

The "Constraint Check Times" pertains to the time interval over which the constraint checking 
will be performed. The "Start Time" and "Stop Time" text fields are used for entering the time 
values. The "Processing Function" buttons allows a user to select the types of constraint 
checking to be performed, including activity-level and command-level checks. 

The "Jobs Information" labeled list shows the status of the ATC Load Generator processing jobs. 
Users can move pending jobs up and down in the queue with the arrow buttons on the right. In 
addition, a user can select a job and choose "Cancel" from the "Jobs" pull down menu to remove 
it from the queue. 

B.2.8.3.3.2 ATC Load Generator "Constraint Check" Display Output 

As a load is being constraint checked, the processing status is displayed in the "Jobs Information" 
portion of the ATC Load Generator window. Once complete, a constraint report will be 
generated for browsing by the user. 

B.2.8.3.4 ATC Load Generator "Simulation" Display 

The ATC Load Generator "Simulation" display is shown in Figure B.2.8.3.4-1. This display is 
shown when the user selects the create "Simulation" radio button at the top of the display. With 
this window, a user can run the ATC Load Generator in an analysis mode, allowing a simulation 
ATC load to be generated for supporting mission tests that involve the spacecraft simulator. 
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Figure B.2.8.3.4-1. ATC Load Generator "Simulation" Display 

B.2.8.3.4.1 ATC Load Generator "Simulation" Display Input 

The ATC Load Generator display contains three pull down menus as described in table 
B.2.8.3.1.1-1. The "Plans" labeled list will show the EOC Master Plan and any user created 
"what if" plans as being available for generating a simulation ATC load. The user selects the 
plan they are interested in from this list labeled list. 

The "Simulation DAS Times" pertains to the portion of the plan over which a simulated ATC 
load will be generated. The "Start Time" and "Stop Time" text fields are used for entering the 
time values. The ATC Buffer "Start Address" text field allows a user to enter a starting memory 
address for simulation purposes. 

The "Jobs Information" labeled list shows the status of the ATC Load Generator processing jobs. 
Users can move pending jobs up and down in the queue with the arrow buttons on the right. In 
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addition, a user can select a job and choose "Cancel" from the "Jobs" pull down menu to remove 
it from the queue. 

B.2.8.3.4.2 ATC Load Generator "Simulation" Display Output 

As a simulation load is being generated, the processing status is displayed in the "Jobs 
Information" portion of the ATC Load Generator window. The output product is a generated 
simulation ATC Load that is available for supporting mission tests that involve the spacecraft 
simulator. 

B.2.9 Communication Contact Scheduler�

B.2.9.1 Communication Contact Scheduler Usage�

The FOT uses the Communication Contact Scheduler tool to schedule uplinks and downlinks and 
to define prototype ids uniquely identify that specify the sequences of configuration codes 
necessary to perform such contacts. 

B.2.9.2 Communication Contact Scheduler Access 

To activate the Communication Contact Scheduler, the user selects it from the "PAS Room" 
provided by FUI. The sample screens are shown in Figures B.2.9.3.1-1 and B.2.9.3.1-2. 
Descriptions of the inputs and outputs for these displays follows. 

B.2.9.3 Communication Contact Scheduler Displays 

B.2.9.3.1 Communication Contact Scheduler Main Display 

This main display shows a list of defined prototype IDs with their associated descriptions, plans 
and allows the user to schedule an event based on start time, stop time, TDRS Id, and start time 
tolerances. 
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Figure B.2.9.3.1-1. Communication Contact Scheduler Main Display 

B.2.9.3.1.2 Communication Contact Scheduler Main Display Input 

The FILE pull-down menu includes the choices QUIT and TRANSMIT. The NEW and EDIT 
options comprise the SAR pull-down menu. The user selects from a list of available prototype 
IDs, including both user-defined and NCC-defined prototype IDs. For a list of possible NCC­
defined prototype IDs, refer to "Data Format Control Document Between the Network and 
Payload Operations Control Centers, Revision 1, December 1994" (hereafter referred to as 
"DFCD"). The user specifies whether the resource ID is HGA, OMNI, or DAS, and whether he 
prefers batch or SAR scheduling. The user also specifies on which plan he is scheduling and 
whether the TDRS used will be west (TDRS-W), east (TDRS-E), or spare (TDRS-S). 
Additionally, he specifies event start and stop times, start time tolerances, and whether the 
contact takes normal or premium support. 
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At the bottom of the screen the user may select from the OK, SCHEDULE, CANCEL, and 
HELP buttons. 

B.2.9.3.1.2 Communication Contact Scheduler Main Display Output 

In response to the user choice of QUIT from the FILE pull-down, the Communication Contact 
Scheduler shuts down. If instead the user selects TRANSMIT, then the prototype IDs and their 
associated configuration code sequences are sent to NCC via UPS. Selecting either NEW or 
EDIT from the SAR pull-down menu brings up Config Codes Display, covered in following 
section, which allows the user to compose a sequence of configuration codes. When EDIT is 
selected, the currently selected prototype ID's information is brought up; this option is provided 
only for user-defined, not NCC-defined, Prototype IDs. 

Pressing the OK button effects all changes made and shuts down the tool. Pressing SCHEDULE 
adds the current contact to the selected plan. CANCEL shuts down the tool and dismisses all 
changes made. Finally, HELP brings up on-line tool information for the user to peruse. 

B.2.9.3.2 Communication Contact Scheduler Configuration Codes Display 

The Configuration Codes displays, for one Prototype ID, a sequence of configuration codes. It 
allows the user to define, or change a prototype id by specifying the service start delta, duration, 
and parameter/value pairs. 
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Figure B.2.9.3.2-1. Communication Contact Scheduler Configuration Codes 
Display 

B.2.9.3.2.2� Communication Contact Scheduler Display Configuration Codes 
Input 

The user builds a sequence of codes from the "Available Configuration Codes" list. (For the 
contents of this list refer to the DFCD.) For a given selected Configuration Code, the user 
specifies the service start delta, duration, and configuration parameter/value pairs. The 
configuration parameters and possible values vary across configuration codes, as specified in the 
DFCD. The user chooses from a group of buttons at the bottom of the display labeled OK, ADD, 
DELETE, CANCEL, and HELP. 
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B.2.9.3.2.2 Communication Contact Scheduler Config codes Display Output 

The sequence of configuration codes is displayed, with the information for each, in the "Selected 
Config Codes" are B. Pressing OK effects all changes made, reflects these changes on the main 
window ("Display 1"), and dismisses the secondary window ("Display 2"). Pressing ADD 
results in adding the current configuration code with its user-specified start delta, duration, and 
parameters to the "Selected Config Codes" list, hence adding the configuration code to the 
current sequence. DELETE removes a configuration code from the current sequence. CANCEL 
dismisses the window without effecting any changes made by the user. HELP brings up on-line 
help for the user to read. 
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